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Introduction 
 
Welcome to the Saint Paul College Student Technology Handbook. This 

booklet has been prepared for your convenience so you can easily access all 

College technologies. Here you will find the basics of getting started with 

e-mail and your account, which will allow access to the College network and 

other resources. 

 

Our College uses electronic mail as its primary and official means of 

communication. Therefore, it is important that you set up your e-mail account 

immediately. 

 

As a student, you may elect to take online courses, or your instructor may have 

online activities available to your class. In either case, you will need to access 

your class through the Desire2Learn (D2L) learning management system. 

 

Listed below are the technology resources and the contact information that you  

may need during the course of your study at Saint Paul College. Please let us 

know if this handbook has been helpful to you. 

 
Help Desk helpdesk@saintpaul.edu 651.846.1440 

D2L Help D2LHelp@saintpaul.edu 651.846.1779 

Library ben.tri@saintpaul.edu 651.846.1489 

eFolio renee.esparza@saintpaul.edu 651.846.1541 
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The Basics 1 
 

There are 3 basic accounts you will need while at Saint Paul College: 

 

1. College eServices Account 

2. Portal Account 

3. Desire2Learn (D2L) Account (if you take online or Web 

enhanced courses) 

 

Saint Paul College e-Services 
 

With a Saint Paul College eServices account you can register, view grades, 

obtain transcripts, update records, obtain award letters, and more. If this is your 

first time logging in, you must use your Student ID and assigned PIN. 

 

From a Windows PC, double click the Internet Explorer browser icon on your 

desktop. If you are using a Macintosh computer, you can use Mozilla Firefox as 

your Internet browser. 

 

Near the top of the page, type the Web address http://www.saintpaul.edu in the 

Address bar. When you have typed in the Web address, click Go or press the 

Enter key on your keyboard. 

 

When the Web site loads: 

 Click Current Students from the menu bar 

 Click eServices 

 In Username, type your 8 digit Student ID (Include leading zeros) 

 Press Tab key on your keyboard 

 In PIN, type your PIN number 

 Click box next to Display My Name to have your name appear on your 

printout (optional) 

 Click Login Now 

 

Your PIN has been preset to one of the following:  

-Your birth date in YYMMDD format if you supplied that information at the 

time of admission. 

-The last six-digits of your Social Security Number (SSN). 

 

Students must change this PIN number to a new 6 digit number.  Do not use 0s 

(zeros) at the beginning of this number. Remember your PIN for future logins. 

At the end of your eServices session, click Logout to ensure that no one else 

can access your records using your computer. Call Enrollment Services at 

651.846.1555 if you have any questions. 

 

Username _______________________________________________ 

 

Password _______________________________________________ 
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The Basics 2 
 

Portal AccountðCollege PCs/Student E-mail 
 

Saint Paul College has set up portal accounts for all students. You will receive 

storage space on the campus computer network for your data files, as well as 

access to a wide range of computer resources that are listed below: 

 Create/Reset your portal account to log on to the PCs in the Library, Open 

Labs and classrooms 

 Access Outlook Live 

 Access the campus wireless system 

 Purchase Microsoft software at discounted prices 

 Pay for printing in the Open Labs (Rooms 3215 & 3225) 
 

To Create Portal Account 
 

From a logged on Windows PC, double click the Internet Explorer browser 

icon on your desktop. If you are using a Macintosh computer, you can use 

Mozilla Firefox or Safari as your Internet browser. 

 

Near the top of the page, type the Web address http://www.saintpaul.edu/portal 

in the Address bar. When you have typed in the Web address, click the arrow 

or press the Enter key on your keyboard. 
 

When the Web site loads: 

 Click Create Portal Account  

 In Tech ID, type your 8 digit Student ID including leading 0s 

 In PIN, type your PIN 

 In Choose a Password, type a new Password 

 In Confirm your Password, retype your Password to confirm 

 Click Create Account 

 

Note: Your Password must be at least 8 characters long, and must include a combination 

of 3 out of the 4 following character types:  1. Numbers (0 - 9); 2. Upper-case characters 

(A - Z); 3. Lower-case characters (a - z); 4. Special characters (@ % & ~ etc.) 
 

A Username and an e-mail address will be generated for your portal account. 

 

Saint Paul College will be using your portal e-mail as the primary and official 

means of communication between the college and students. It is important that 

you check your college e-mail frequently. Call IT Help Desk at 651.846.1440 if 

you have any questions. 

 

Username _______________________________________________ 

 

Password _______________________________________________ 

 

E-mail Address __________________________________________ 
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The Basics 3 
 

Desire2Learn (D2L) 
 

Students registering for online learning courses will automatically be enrolled 

in their D2L courses. Once you have access to the Internet, you can access your 

online course from anywhere, any time of the day using Internet cable, DSL or 

a dial-up modem. 

 

Your Username will be your 8 digit Student ID (including leading 0s) and your 

Password will be your birth date in the YYMMDD format. You will be 

prompted to change your Password for security purposes. 

 

Accessing Desire2Learn 
 

From a Windows PC, you can locate Internet Explorer on your desktop. Double 

click the Internet Explorer icon. If you are using a Macintosh computer, you 

can use Mozilla Firefox as your Internet browser. 

 

Near the top of the page is the Address bar.  

 Type https://saintpaul.ims.mnscu.edu in the white space 

 When you have typed in the Web address, click Go or press the Enter key 

on your keyboard 

 

Note the s after the http and that there is no www. 

 

This will take you to the Saint Paul College online learning Home page, an 

area designed as a launch pad to all of your Saint Paul College online courses. 

Now that you have successfully accessed Saint Paul Collegeôs D2L Home 

page, perform a system check by clicking Click here to perform a System 

Check and log in to D2L. Video instructions are located on the Home page. 

For more information on your Desire2Learn account, see Online Learningð

Accessing Desire2Learn on page 6. 

 

At the end of your D2L session, click Logout to ensure that no one else can 

access your online course using your computer. Call D2L Help Desk at 

651.846.1339 if you have any questions. 

 

D2L Technical Support 
 

E-mail: D2LHelp@saintpaul.edu 

 

Username _______________________________________________ 

 

Password _______________________________________________ 

 

 

 



 7 

Saint Paul College E-mail Policies 
 

Saint Paul College E-mail Policies 
 

Chapter 5 - Administration 

05.25.01.0  Student E-Mail Policy 

 

Purpose of the Policy 
 

To establish e-mail as the recognized official means of communications from 

the College to the student body. 

 

College Use of E-Mail: E-mail is the official means for communication at 

Saint Paul College.  Every student must have an official Saint Paul College  

e-mail address.  Every student is expected to check his/her e-mail on a frequent 

and consistent basis in order to stay current with College communications that 

may be of a time sensitive nature. 

 

Compliance with Related Policies:  All e-mail messages must adhere to 

Minnesota State Colleges and Universities Systemôs Acceptable Use of 

Information Technology Policy (http://www.mnscu.edu/board/policy/522.html) 

and Procedures http://www.mnscu.edu/board/procedure/522p1.html),  

Minnesota State Colleges and Universities System Code of Conduct and Ethics, 

and Minnesota Statutes 43A.38, Subd. 4 and 43.A39, Subd.2, and the Family 

Educational Rights and Privacy Act of 1974, as amended. 

 

As with all electronic communication, users must assume that e-mail is not 

private and not confidential.  Users must exercise caution in communicating 

sensitive material.  When necessary communications will be provided in 

alternative formats to meet ADA requirements. 

 

Reference:  MnSCU 5.22 

Date: 051607  Rev. 

Review Date:  051609 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.mnscu.edu/board/policy/522.html
http://www.mnscu.edu/board/procedure/522p1.html
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Electronic Mail (E-mail) 
 

Outlook Live Access 
 

Microsoft Outlook Live, provides student access to mailboxes via the Internet. 

To use this service you must:  

 

 Have an existing student portal account at Saint Paul College 

 Have access to the Internet via a Web browser (We recommend that you 

use Microsoft Internet Explorer 6.0 or above) 

 

Logging On 
 

From a Windows PC, you can locate Internet Explorer from your desktop. 

Double click the Internet Explorer icon. If you are using a Macintosh 

computer, you can use Mozilla Firefox as your Internet browser. 

 

Near the top of the page, type the Web address http://www.saintpaul.edu/portal 

in the Address bar. When you have typed the Web address, click the arrow, or 

press the Enter key on your keyboard. 

 

When the Web site loads: 

 Click on Student e-mail under Links on the left 

 Type in your complete e-mail address in the Windows Live ID field 

 Type your Password in the Password field 

 Click Sign in to continue 

 

You are now logged on to your mailbox, where you can read, compose and 

send e-mail and access your Address book and Calendar. For more 

information on your portal e-mail account, see E-mail How-Tos on page 9. 

 

At the end of your portal e-mail session, click Sign out to ensure that no one 

else can access your e-mail using your computer. 
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E-mail How-Tos 
 

How to Create a Message 
 

You can create messages in the new message form. This is the 
same form that's used for replying to and forwarding messages.  

 1.  In any mail folder, click New , or press C TRL+N on the 

keyboard.  
You can also create a new message while you're viewing 

the address book. On the toolbar, click Address Book 
, and then use the search text box to find the person or 

distribution list you want to send a message to. Right -
click the re cipient's name in the list, and then click 

New Message.  

2.  Enter the recipients you want in To and Cc. For more 
information about recipients, see Add or Remove 
Recipients . 

3.  Type a subject.  
4.  Type you r message in the message body.  
5.  When you're finished typing the message, click Send 

or press ALT+S to send it.  
 

 

How to Open a Message 
 

You can view your messages in the reading pane, or you can open 
them in a separate browser window.  

How to use the preview pane 
 

Click the message you want to read, and it will appear in the 
preview pane.  
 

How to open a message in a separate window  

 
1.  Find the message you want to read in Mail.  
2.  Double -click the message to open it, or select the 

message and then press ENTER  on keyboard . 
 

http://help.outlook.com/en-us/140/bb899522.aspx
http://help.outlook.com/en-us/140/bb899522.aspx
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E-mail How-Tos (contôd) 
 

How to Attach a File 
 

You can attach any kind of file that can be accessed from your 
computer or through your network to any item you create in your 
mailbox.  

1.  In a message, calendar item, or contact, click the attach 
file icon on the toolbar.  

2.  In the Attach Files dialog box, type the path of the file 
you want to attach, or click Browse to locate the file.  

3.  If you use Browse, highlight the file you want to attach, 
and then click Open to add it to the attachments list.  

4.  Click Attach, and the file name will appear in the Attach 
Files dialog box.  

5.  To change the file you selected, click Browse, and then 
locate the file you want.  

6.  To attach more than one file, click Choose more files in 
the Attach Files dialog box.  

7.  To return to th e item, click Attach to attach the selected 

files or click Cancel to return to the item without 
attaching the files.  
 

How to Remove an Attachment  
 

You can remove an attachment from an item.  
1.  Open the item, and then click the attachment you want to 

remove.  

2.  Press DELETE on the keyboard to remove the attachment.  
 

How to Open an Attachment?  
 

When an item includes an attachment, a paper clip icon is 

shown next to the item in the list window.  
When the item is opened or previewed, the name of the attached 
file  appears in the item information. Some attachments, such as 
.txt files and .gif files, are opened directly by the Web browser.  

1.  Click the attachment file name located in the message 
heading information. You have the option to open the 
attachment using the a ppropriate application or save the 
attachment to disk.  

2.  You can also use Open as Web Page to open the 
attachment using your Web browser.  
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E-mail How-Tos (contôd) 
 

How to Check Spelling 
 

You can check the spelling in your messages and meeting requests 

before  you send them.  

1.  After you compose a message or while you're composing 

a message, click in the body of the message.  

2.  On the toolbar, click Check Spelling or press F7. The 

spelling c hecker will underline each word it doesn't recognize 

in red.  

3.  Right -click an underlined word for a list of suggested 

corrections. Click a suggestion to substitute it for the 

misspelled word.  
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E-mail How-Tos (contôd) 
 

How to Reply to or Forward a Message 
 

You can reply to or forward a message.  
 How do I reply to a message?  
To reply only to the person who sent the message:  

1.  Select the message in the message list or open the 
message.  

2.  On the toolbar, click Reply . A new message will 

appear addressed to the  sender of the original message.  
To reply to the sender of a message and all other recipients:  

1.  Select the message in the message list or open the 
message.  

2.  On the toolbar, click Reply All . A new message will 

appear addressed to the sender and to all othe r recipients 

of the original message.  
3.  When you're ready to send your reply, click Send on 

the toolbar or press ALT+S.  
 

How to Forward a Message  

1.  Select the message in the message list or open the 
message. On the toolbar, click Forward .  

2.  In the To box, t ype the e -mail address you want to 
forward the message to.  

3.  When you're ready to send your forward, click Send on 

the toolbar or press ALT+S.  
 

 

How to Delete a Message 
 

When you delete a message, the message is moved to the Deleted 
Items folder.  
 
To delete  one or more messages from a folder, select the 
messages, and then do one of the following:  

 Click Delete on the toolbar.  

 Right -click the message and then click Delete on the 
menu.  

 Press the DELETE key  on keyboard . 
To delete an opened message, click Delete on the toolbar.  

 

Note: All deleted messages are sent to the Deleted Items folder. They aren't 

permanently removed until you delete them from the Deleted Items folder. 
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E-mail How-Tos (contôd) 
 

How to Add a Signature 
 

An e-mail signature consists of text or pictures that can be added to the end of 

an outgoing e-mail message. 

 
 At the top of the Outlook web application page, click 

Options  > Settings  > Mail .  
 In the E-Mail Signature  box, type and format your 

signature.  
 To add your signature to all outgoi ng messages, select the 

Automatically include my signature on outgoing messages  
check box.  

 Click Save  or press CTRL+S.  

 

 

 

 

 

 

 

 

 

Important Notes Regarding Junk E-Mail 
 

Use the Junk E-Mail tab to help control unwanted and unsolicited 

messages by creating and managing lists of e -mail addresses and 

domains that you trust and those you don't.  

To manage junk e -mail settings, go to Options > Junk E-Mail.  

 

Never reply to Junk E-mail messages. 

 

 

 

 

 
Do NOT reply to SPAM. 
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Instructional Technology Center (ITC) 
 
The Instructional Technology Center at Saint Paul College serves all students 

who need access to computers on campus and comprises: 

 Open Labs 

 Assessment Center 

 Developmental Learning Center 

 

Open Labs 
 

Location: Rooms 3215 and 3225 (Third Floor) 

Computer labs are open to all students at convenient times. These labs offer 

flash drive accessible computer access to a variety of business-related and 

academic computer applications, Internet access, and programming languages. 

Student workers are available in each of the labs to answer questions and to 

help solve computer software and hardware problems. 

 

Note: No food or beverages are allowed at the desktop area and cell phones 

must be turned off or on vibrate. 

 

Standard Software on Windows PCs 
 

Word   Access   Adobe Reader 

PowerPoint  Publisher   Quick Time 

Excel   Internet Explorer  WinZip 

 

Some PCs feature specialty software such as AutoCAD, LandDesktop, health 

designed programs and instructor requested applications for student 

coursework.  

 

Printing 
 

Rooms 3215 and 3225 each are equipped with a black and white laser jet 

printer. You will need to have a portal e-mail account and funds in your 

GoPrint account to access the printing system and to retrieve your copies. Each 

student is credited with 250 free pages for printing in the open labs. See 

Printing Documents on page 22. 

 

ITC Hours 
 

Monday ð Thursday: 7:30am to 10:00pm  

Friday: 7:30am to 4:00pm  

Saturday: 7:30am to 2:00pm  

 

Hours are subject to change for holidays, school closings, summer hours and 

special events. Call Open Labs at 651.846.1779 if you have any questions. 
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Instructional Technology Center (ITC) 
 

Assessment Center 
 

Location: Room 3115 (Third Floor) 
The Assessment Center offers computerized basic skills assessment as part of 

the admissions process to help ease the transition to college. A College Board 

assessment instrument will be administered to assess basic writing, reading, and 

numerical skill competencies. Keyboarding and other assessment instruments 

are also available as well as CLEP, Nursing Assessments, Microsoft, 

CompTIA, and Novell certification testing. 

 

Note: No food or beverages are allowed at the desktop area and cell phones 

must be turned off or set on vibrate. 

 

Assessment Hours 
 

Monday ð Thursday: 9:00am to 6:30pm  

Friday: 9:00am to 12:30pm  

Saturday: 9:00am to 10:30am 

 

 

 

 

 

 

 

 

 

 
Hours are subject to change for holidays, school closings, summer hours and 

special events. Call the Assessment Center at 651.846.1553 if you have any 

questions. 

 

Other Testing 
 

The College provides alternative testing space for students with individual 

needs.  We also offer an array of testing formats such as VUE, CLEP, and 

ACT. 

 

By Appointment Only 

Contact Cindi Braun: 651.846.1553 

 

Hours are subject to change for holidays, school closings, summer hours and 

special events. Call the Assessment Center at 651.846.1553 if you have any 

questions. 
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Instructional Technology Center (ITC) 
 

Developmental Learning Center 
 

Location: Room 3125  

The Developmental Learning Center is available to students to assist them in 

the development or upgrading of their basic reading, grammar and math skills. 

Utilizing computer-based courseware, students are able to work on basic skills 

development at their own pace and on their own schedule under the supervision 

of faculty and center staff. Current software used is EnableMath and PLATO. 

Computer tutorials are also available for science and major program 

coursework. If not enrolled in EnableMath or PLATO, please see a lab assistant 

for computer use. 

 

Note: No food or beverages are allowed at the desktop area and cell phones 

must be turned off or on vibrate. 

 

Developmental Learning Center Hours 
 

Monday ð Thursday: 7:30am to 10:00pm  

Friday: 7:30am to 4:00pm  

Saturday: 7:30am to 2:00pm  

 

Hours are subject to change for holidays, school closings, summer hours and 

special events. Call the Developmental Learning Center at 651.846.1780 if you 

have any questions. 
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Online Learning 

Accessing Desire2Learn 

 

Desire2Learn (D2L) 
 

Username will be your 8 digit Student ID (including leading 0s) and Password 

will be your birth date in YYMMDD format. You will be prompted to change 

your Password for security purposes. At end of your login session, click 

Logout to ensure that nobody else can access your online course using your 

computer. 

 

Accessing Desire2Learn 
 

From a Windows PC, you can locate Internet Explorer on your desktop. 

Double click the Internet Explorer icon. If you are using a Macintosh 

computer, you can use Mozilla Firefox as your Internet browser. 

 

Near the top of the page is the Address bar. Type in the white space 

https://saintpaul.ims.mnscu.edu. Note the s after the http and that there is no 

www. When you have typed in the Web address, click Go or press the Enter 

key on your keyboard. 

 

This will take you to the Saint Paul College online learning Home page; an 

area designed as a launch pad to all of your Saint Paul College online courses. 

Now that you have successfully accessed Saint Paul Collegeôs D2L Home 

page, perform a system check by clicking Click here to perform a System 

Check and log into D2L. Video instructions are located on the Home page. 
 

Accessing Your Online Course 
 

In the center of your My Home page is My Saint Paul College Courses 
 

 Click the desired course link 
 

To access course related material, click Content on the 2nd blue navigation bar 
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Online Learning 

Accessing Desire2Learn (contôd) 
 

Accessing Course Tools 
 

From the bottom blue navigation bar, you can access the following by clicking: 

 Content ï this includes, but is not limited to: syllabus, assignments, 

PowerPoint presentations, external Web links, PDFs, practice quizzes, etc. 

 Discussions ï asynchronous discussion board 

 Chat ï synchronous (real time) chat rooms which can be private or public 

 Classlist ï directory of names, e-mails, and the group setup which allows 

you quick access to classmates and/or instructor 

 Dropbox ï area where you submit your assignments electronically to your 

instructor 

 Links ï an interactive tool that allows you to browse through available links 

 Checklist ï area where you can use as a visual guideline to determine what 

needs to be accomplished 

 Quizzes ï lists past, current, and future quizzes 

 Grades ï enables you to view your progress as well as any comments 

given by your instructor 

 Help ï explanation of individual Desire2Learn tools 

 Survey ï anonymously answered surveys relating to the course 

 
From the top blue navigation bar, you can access the following by clicking: 

 My Home ï initial page after logging into Desire2Learn 

 E-mail ï outgoing e-mail only 

 Locker ï this is an area where you can upload and store personal files  

pertaining to your course 

 Logout ï log out of your Desire2Learn course 

 

D2L Technical Support 
 

E-mail: D2LHelp@saintpaul.edu 

Marti Docken: 651.846.1339 

Dan Thompson: 651.846.1779 
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Electronic Portfolio (eFolio) 
 

Electronic Portfolios 
 

Electronic portfolios are a multimedia application designed to help you create a 

living showcase of your education, career and personal achievements. All 

Minnesota residents, including students at Saint Paul College, can use eFolio 

Minnesota to reach their career and education goals. 

 

To create an eFolio account: 

 Visit http://www.efoliominnesota.com 

 Click Sign Up on the menu to the right 

 Click Sign Me Up 

 

For more information contact: 

      Renee Esparza - renee.esparza@saintpaul.edu 651.846.1541 
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Library Technology 
 

Libraryð MnPALS 
 

The Libraryôs Web page, http://www.saintpaul.edu/library, contains links to the 

library catalog and over 45 databases, almost all of which can be accessed on or 

off campus. It contains help sheets for research paper citation, how to tell a 

scholarly article from a ñpopularò one, and sample sheets of what the Library 

collection has on almost any subject taught at Saint Paul College. 

 

The Library catalog, available as a link from the Library page, or by going 

directly to http://saintpaul.mnpals.net, lets you search for anything in our 

collection, and lets you use interlibrary loan to request items from other 

academic libraries. Patrons can also see what they have checked out or renew 

their own materials by logging onto the catalog. 

 

You can find articles through our databases, which are arranged by title, 

subject, and description. Most of the databases have full-text articles, meaning 

you donôt have to find the print version to get the entire article. In most of the 

databases you will also have the option to print out, save, or e-mail the articles 

to yourself. Databases that require you to login if you are using them off-

campus will ask for your barcode (back of your school photo ID) and your last 

name. If you have not yet received your photo ID, you may use the e-mail link 

on the database pages to contact the librarian for an assigned barcode. In order 

to ensure a studentôs identity, the barcode will be sent only to their school  

e-mail address. 

 

The Library has a printer/copier capable of black and white, color, and double-

sided copying. Library computers have access to the Internet and Microsoft 

Office (Word, Excel, PowerPoint, Access, Publisher). Printing from any 

computer costs 5 cents per page for black and white, 50 cents for color. 

 

The Library has a television with a VCR and DVD player to view, reserve or 

reference videos/DVDs. All other videos/DVDs can usually be checked out for 

one week. 
 

Library Hours 
 

Monday ï Thursday: 7:15am to 8:00pm 

Friday: 7:15am ï 4:00pm 

Saturday & Sunday: Closed 
 

Photo ID 
 

Your student photo ID is your Library card. Your photo ID is required to check 

anything out of the Library. On the back of the ID is your barcode, which most 

of the databases use as your user login when you are not on campus. If you do 

not have or have lost your Student ID, we will only accept a driverôs license or 

state photo ID for checking out materials.  

http://www.saintpaul.edu/library
http://saintpaul.mnpals.net/
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Printing Documents 
 

Printing Documents in the Saint Paul College Open 

Computer Labs (Rooms 3215 & 3225) 
 

Printing in Open Labs is done completely online. Other departments may have 

different printing procedures. See the appropriate staff. 
 

Saint Paul College Student Laser Print Allowance 
 

Each enrolled student is automatically given a print allowance as part of their 

student portal account.  At the beginning of each term, each enrolled student 

will receive free pages in his/her student account. If you use all of your free  

8.5 x 11 black and white pages, you will be charged for any additional black 

and white print copies at a rate of 5 cents per page. You can add money to your 

print account at the Add Value Station located on the 3rd floorðStudent 

Commons area.  The number of free pages in the print allowance may vary 

from semester to semester. 
 

Print balances do not carry over to the next semester. At the end of the term, 

any remaining print balance will be deleted. The print balance has no cash 

value, so there is no refund or transfer for unused print copies. Deletion of 

remaining print copies begins at 10:00pm the evening prior to a new term. At 

the beginning of the next term, free pages will be reinstated when you enroll in 

classes. 
 

Print Allowance Eligibility 
 

Only students currently enrolled in classes are eligible to receive a print 

allowance. Saint Paul College faculty and staff do not receive a free print 

allowance unless they are enrolled in a credit course. 
 

How to Print from the GoPrint PayStation 
 

In order to print, you will need your student portal account. Printing 

instructions may vary slightly from one location to another. General guidelines 

for printing: 
 

 Go to the GoPrint PayStation monitor located next to the printer 

 Click your Username (portal account Username) 

 You will see a list of your current print jobs waiting and their cost 

 Click the job that you want to print 

 Click Continue 

 Type your portal account username in the login ID field 

 Type your Password (portal account Password) in the password field 

 Click Sign In 

 You can view the balance in the upper right hand corner of screen 

 To accept charges, click Pay and Print 

 Pick-up your print job(s) from printer 

 Note: All print jobs will be deleted automatically after a 2 hour period. 
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Printing Documents (contôd) 
 

How to Add Money to Your Student Account Using 

the Add Value Station 
 

Users may add money to their student account through the following method: 

 Go to the Add Value Station located in Room 3225 next to printer 

 Type your portal account Username using the keyboard 

 Press Enter on keyboard 

 Type your portal account Password using the keyboard 

 Press Enter on keyboard (Your account will be verified) 

 Insert cash in cash slot (Your account will be updated) 

 Press D on key pad to end session 

 Take your receipt 
 

Note: No coins or credit cards are accepted. 

 

Student Printing Policies and Guidelines 
 

Locations 

The Open Labs are located in rooms 3215 and 3225. Instructions are posted at 

each printer location. Labs that are not part of this program will have their own 

printing policies and are NOT part of the print allowance. 
 

Shared Location 

Your allowance is shared by both rooms 3215 and 3225. If you print in 

multiple labs, all printing is drawn from the same allowance total. 
 

Printing Allowance Restrictions 

The printing allowance is intended for your academic use only. You may not 

use your allowance to print other peopleôs work or sell your unused allowance. 

You may not use your printing allowance for commercial purposes. 
 

Conserve Your Printing Allowance 

Your printing allowance is intended to be used throughout the semester. It is a 

good practice to conserve your printing so you will be able to print your work 

through the entire semester. This is particularly important when your 

coursework requires significant printing for final reports or projects. 
 

No Refunds for User Error 

Please preview your print job thoroughly before printing to avoid unwanted 

blank pages, extra pages, or other errors. You will be charged for these pages 

and there are no refunds. 
 

Refunds Due to Printer Error 

Page refunds are issued only for problems due to defective equipment, such as 

paper jams or missing ink/toner. Refunds consist of replacement pages only. 

Your printing allowance has no cash value. Please allow a 24 hour 

turnaround (business days only) for any page refunds. 
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Saving & Opening Documents (Office 2007) 

 

Save a Copy of a File (Save As command) 
 

 Click the Microsoft Office Button, and then click Save As 

Tip: If you donôt see the Microsoft Office Button, click Save As on 

the File menu 

 In the File name box, enter a new name for the file 

 Click Save 
 

Tip: To save the copy in a different folder, click a different drive in the 

Save in list for a different folder in the folder list. To save the copy in a 

new folder, click the Create New Folder button. 
 

Note: Your portal account gives you access to the H: drive located on the 

College Network to save your documentsðUsername on óstuhome\student (H:) 

 

Save a File to Another Format 
 

 Click the Microsoft Office Button, and then click Save As 

 Tip: If you donôt see the Microsoft Office Button, click Save As on 

the File menu 

 In the File name box, enter a new name for the file 

 In the Save as type list, click the file format that you want to save the file 

in 

 Click Save 

 

How to Open a File 
 

 Click the Microsoft Office Button, and then click Open 

Tip: If you donôt see the Microsoft Office Button, click Open on the 

File menu 

 In the Look in list or Navigation pane, click the, folder, drive, or 

removable media (flash drive, diskette, CD, or DVD), or Internet location 

that contains the file you want to open 

 Click the file, and then click Open 
 

Note: By default, the files that you see in the 

Open dialog box are only those files that are 

created by the program that you are using. If you 

are using Microsoft Office Excel, you do not see 

files that are created by using Microsoft Office 

Word unless you click All Files in the Files of 

type box. 
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Wireless Access 
 

Requirements for Using Wireless at Saint Paul  

College 
 

 Students must create an account from the student portal 

 Students must have a wireless card in their laptop or other device  

 Disable the Firewall option in McAfee, Symantec, and Microsoft if present  

 

How to Configure Your Laptop to Connect to the 

Service Set Identifier (SSID): spcwna 
 

From the Properties of the My Network Places icon, right click the Wireless 

Connection icon, select View Available Wireless Networks. 

 

Click Connect and then click Connect Anyway. You will see the SSID name, 

Speed, Signal Strength and Status Information. Open the Web Browser and 

type your Username and Password. 

 

For assistance, contact Computer Services at 651.846.1440 or visit Room 4270. 
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Computer Usage Policy 
 

Computer Usage Policy 
 

The following is an excerpt from the Minnesota State Colleges and Universities 

system-wide policy on computer and information usage. Students are 

responsible to understand the following policies and procedures. For a 

complete policy and procedure visit the following Web site: 

 

http://www.mnscu.edu/board/procedure/522p1.html 

 

Users must abide by the security restrictions on all systems and information to 

which access is authorized. 

 

1. Users must not:  

a. use any account or password assigned by the college or university to 

anyone else; 

b. share any account or password, assigned to the user by the college or 

university, with any other individual, including family members; 

c. allow others to use System information technology under the 

userôscontrol;  

d. use System cellular telephones or computer dial-up services for 

personal use unless specifically authorized by System or State policy or 

procedure. 

 

2. Users must not circumvent, attempt to circumvent, or assist another in 

circumventing security controls in place to protect the privacy and integrity 

of data stored on System information technology. 

 

3. Users must not change, conceal, or forge the identification of the person 

using System information technology, including, but not limited to, use of e-

mail. 

 

4. Users must not knowingly download or install software onto System 

information technology unless it has been pre-approved through established 

campus or system office procedures, or by the designated officials, or prior 

authorization is received from the designated officials. Users who knowingly 

or negligently do not comply may be held responsible for damages, cost of 

system debugging, and payment of software fees, licenses and infringement 

penalties. 

 

5. Users must not engage in activities that interfere with or disrupt network 

users, equipment or service; intentionally distribute viruses, worms, trojans, 

or other malicious code; or install software or hardware that permits 

unauthorized access to System information technology.  

 

 

 

http://www.mnscu.edu/board/procedure/522p1.html
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Computer Usage Policy (contôd) 
 

6. Users must not engage in inappropriate uses, including: 

a. activities that violate State or federal law or regulation  

b. wagering or betting;  

c. harassment, threats to or defamation of others, stalking, and/or illegal 

discrimination; 

d. fund-raising, private business, or commercial activity, unless it is 

related to the mission of the System or its colleges and universities. 

Mission related activities are determined by the college, university, or 

Office of the Chancellor, and include activities of authorized campus or 

System-sponsored organizations; 

e. storage, display, transmission, or intentional or solicited receipt of 

material that is or may be reasonably regarded as obscene, sexually 

explicit, or pornographic, including any depiction, photograph, audio 

recording, or written word, except as such access relates to the 

academic pursuits of a System student or professional activities of a 

System employee; and  

f. ñspammingò through widespread dissemination of unsolicited and 

unauthorized e-mail messages. 

 

Conduct which involves the use of information resources to violate a System 

policy or procedure, or state or federal law, or to violate anotherôs rights, is a 

serious abuse subject to limitation or termination of user privileges and 

appropriate disciplinary action, legal action, or both. 

 

Minnesota State Colleges and Universities reserves the right to temporarily 

restrict or prohibit use of its System information technology by any user 

without notice, if it is determined necessary for business purposes 
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Important Links 
 

Saint Paul College 
http://www.saintpaul.edu 

 

FAFSA 
http://www.fafsa.ed.gov  

 

Student Portal 
http://www.saintpaul.edu/portal/ 

 

Desire2Learn (D2L) 
https://saintpaul.ims.mnscu.edu 

 

Library 
http://www.saintpaul.edu/library/ 

 

MnPALS 
http://saintpaul.mnpals.net 

 

MnSCU Computer Policy 
http://www.mnscu.edu/board/procedure/522p1.html 

 

My Important Links 
 
 ________________________________________________________ 

 
 ________________________________________________________ 

 
 ________________________________________________________ 

 
 ________________________________________________________ 

 
 ________________________________________________________ 

 
 ________________________________________________________ 

 

________________________________________________________ 

 

________________________________________________________ 

 
 ________________________________________________________ 

 

________________________________________________________ 
 


